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Shaan has been a passionate user of AutoCAD®, first as a customer and now as a technology evangelist 
for over 18 years. He has been with Autodesk since 1998 and currently works with the AutoCAD family of 
products. Shaan was trained as a mechanical designer and has used many of the Autodesk® products as 
a customer prior to joining Autodesk. When not blogging, Shaan spends most of his time speaking with 
customers and gathering feedback and suggestions, which help shape future product development. 
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In this class, you will learn about AutoCAD for Mac as well as the differences between AutoCAD for 
Windows and AutoCAD for Mac. I will be showing some of the common AutoCAD workflows and how 
they apply to AutoCAD for Mac specifically.  

I am truly excited that Autodesk has developed and brought to market a Mac native version of AutoCAD. 
It has been a couple years in the making and has taken a monumental effort of going through several 
million lines of code and OS platform specific dependencies. Just because Apple switched to the Intel 
processer a few years back did not mean that there was a magical switch to get Intel based applications 
built for other operating systems up and running on Mac OS X; otherwise, you can be sure Autodesk 
would have used that option a few years ago.  

I am really an agnostic OS platform person, in that I don’t really care about which OS I am using as long 
as it runs the applications I use to complete the tasks I need to perform.  I am excited that there is now a 
choice of the platform when running AutoCAD. Users can make the decision themselves instead of using 
a platform solely because an application they rely on is only available on that one. Choice is good!  I do 
hope you are attending this class because your platform of choice is the Mac or perhaps you want to see 
what is on the other side of the platform fence.  

AutoCAD for Mac was designed and developed for the Mac and AutoCAD user in equal amounts to hit 
the delicate balance of still being AutoCAD, yet the look and feel of a native Mac experience.  

The first native Mac version of AutoCAD for Mac was developed for smaller customers, not the large 
enterprise. Autodesk looked at what was the most important features required by these Small to Medium 
sized Businesses "SMB" users. While not all features are included, some just did not make sense for the 
first release or relied on platform specific technology. There are also some features in AutoCAD for Mac 
that are not in the AutoCAD for Windows version. We will not be debating which platform is better or 
“cooler” as that is left to your own preference as it should be. 

 

 

If you are worried that Autodesk has finally gotten rid of the Command line, 
then you can rest easy now and I won’t torture you until later in this class.  

The long loved AutoCAD Command line is included in AutoCAD for Mac. 
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 Hardware and System Requirements 

The most common questions I am asked is about hardware support. From those that already own a Mac 
“is their system sufficient to run AutoCAD for Mac”, and from those without a Mac is “what Mac hardware 
should I get to be able to run AutoCAD for Mac”. 

The General Rule of Thumb is any Mac computer released after January 1, 2009 from the Mac Mini to the 
awesome powered Mac Pro workstations. 

 

The most powerful machine is the Mac Pro all the way on the right, if you work on large drawings or 
complex 3D, this is the system you should be looking at.  

The least capable system is the Mac mini. I have ran AutoCAD for Mac on the Mac mini but the 
performance is limited due to hardware and sufficient for mainly 2D drawing but the Mac mini is only $600 
and a great entry point to a Mac. 

In the middle and what I use is the MacBook Pro. This is a powerful laptop and sufficient for most 2D and 
3D in AutoCAD for Mac. I use the 15” MacBook Pro with the enhanced graphics and matte screen as 
opposed to the glossy but that is just my personal preference. 

AutoCAD for Mac supports input devices like the Standard Apple mouse, Apple Magic Mouse, Apple 
Magic Trackpad and even IBM standard mice (2 buttons with or without a wheel) you may use on your 
PC.  
 
Best of all, AutoCAD for Mac supports finger gestures using the Trackpad and Magic Mouse. 
http://support.apple.com/kb/HT3211  

 

 
 

Mac 
mini 

MacBook MacBook Air MacBook Pro iMac Mac Pro 
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Apple Mac OS X 101 
 
Let’s get you sounding like a veteran Mac OS X user by going over some terminology and user interface 
elements. OS X is pronounced “Mac OS Ten”. 

OSX Interface 

 

Keys to Success 

The keyboard on a Mac is a little bit different from a PC. The biggest will be getting used to using the 
Command key instead of Control for your most common commands, such as copy, paste, etc.  Delete 
also works differently. 
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AutoCAD for Mac User Interface “UI” 

Let’s take a look at AutoCAD for Mac UI as that is the first thing you are faced with after launching 
AutoCAD for Mac.  

AutoCAD for Mac was designed from the ground up and not a port of AutoCAD for Windows running on 
Mac OS X. Both AutoCAD and Mac users were consulted throughout the design and development 
process to make sure that while it was using the standard Mac features and workflows, that it was still 
AutoCAD under the hood. 

The graphical interface of AutoCAD for Mac takes full advantage of Mac OS X features including the 
different aspect ratio of the display so vertical palettes were used. 

 

 



AC333-3: "I am a Mac and a PC": AutoCAD® for Windows® and Mac® – We Both Speak AutoLISP® and Command Line 

6 
 

In my experience after meeting with AutoCAD users all over the world, the AutoCAD for Windows users 
take less than a few minutes to get off the ground and running with AutoCAD for Mac. This is not only due 
to the intuitive UI, some familiar AutoCAD interface features, but also the Command line support. Even in 
the Command line, you can use the familiar behaviors such as arrow up or down to navigate recent 
commands or press Tab to show matching command names such as entering “D” and then tabbing 
through all commands and system variables that start with “D”. You can also use the Help menu to locate 
commands that are not as frequently used. Clicking a command in the search results shows where it is 
located on the menu bar with a pointer to highlight its location. 
 

 

AutoCAD for Mac Terminology 

 
 
1. Application menu bar  
2. Drawing area  
3. ViewCube tool  
4. Palettes  
5. Coordinate display  
6. Status bar  
7. Command line  
8. UCS icon  
9. Tool Sets palette  
10. Viewport label menus (also known as Viewport controls) 
11. Spotlight search 
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Mac OS X Finder Window 
 
Mac OS X has a feature known as Finder, which is similar to Windows Explorer on the Windows platform. 
In Finder there is a mode named Cover flow. Cover Flow allows you to visually scroll through preview 
images of documents similar to scrolling through album art on iTunes.  You can view AutoCAD for Mac 
drawing previews using Cover Flow. I must say Cover Flow is awesome and gets Oohs and Ahhs from 
other OS users. Spotlight search is a seriously helpful and well implemented Mac OS X feature and 
AutoCAD for Mac uses it throughout the product from the main application menu to the Application 
Preferences dialog. Just use +Spacebar to search for drawings and more. 

 

1. Spotlight search  
2. Filename  
3. Cover Flow scrollbar  
4. Cover flow splitter to adjust preview size  
5. Filename list  
6. Directory > Active folder  
7. Places sidebar item  
8. Cover Flow pane toggle  
9. Drawing (DWG) file preview 
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Now let’s look at some of the features and workflows in AutoCAD for Mac 

QuickView  
 
I did not take the alphabetical route to features and just started at one of my favorite AutoCAD for Mac 
specific features, QuickView. This is not the same as the QuickView in AutoCAD for Windows. This is a 
real sweet spot in AutoCAD for Mac. You can see and visually scroll through all open drawings and their 
Layouts. 

 

Tool Sets Palette 1 
 
The Tool Sets palette is like a vertical toolbar menu. You can change the tool sets at the top of the palette 
from Drafting, Annotation, and Modeling for the task you are doing. 
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Content Palette 2 
 
The Content palette allows you to visually browse block definitions in the current drawing and insert them 
into the current drawing. You can also manage blocks from drawings as favorites much like the Design 
Center. The Content palette can be used to create libraries of blocks from drawing files; each block in a 
library is represented by a single drawing file.  
 

  

Command Line 3 
 
The much loved AutoCAD Command line is right here (well left here because it is on the left side) at the 
bottom of the UI in case you need it or you can hide it if you like. It functions much like the AutoCAD for 
Windows version allowing you to pound out commands in blazing speed including your command aliases. 
The command line can be expanded but there is no F2 Text window option. 
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Layers Palette 4 
 
The Layers palette is quite a bit different than you may be used to in AutoCAD for Windows. While most 
of the same abilities are there, it has been Mac’ified (if that is a word). 

 

Properties Inspector Palette 5 
The Properties Inspector is where you do most everything from changing objects to editing layer 
properties to controlling visual styles and rendering settings such as the sun. This type of palette is 
common in Mac applications and known as Inspector palettes. 

 

Status Bar 5 
The status bar located below the drawing window is much like you are used to in the AutoCAD for 
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Windows. The status bar can be expanded to two lines or the default of one line. The expanded status 
bar reveals  

 

Reference Manager Palette 7 
The Reference Manager is a bit different than the External Reference Manager palette in AutoCAD for 
Windows. 

 

 

 

 

If you are a minimalist AutoCAD user, you will appreciate 0 Clean Screen mode to get everything off 
your screen but the drawing window. 
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Now let’s look at two typical AutoCAD 2D Workflow tasks 

Dimensioning 
This staple AutoCAD feature is as you would expect and no real differences. 
 
Printing 
Of course you would not have AutoCAD without being able to print the design. You can select 
Print from the File menu, QuickView, or press Command-P ( P) and prepare a print. The Print 
dialog is the standard Mac OS X version with some subtle differences. When printing from Model 
space, click Advanced to change plot styles, plot stamps, etc. Click  Edit Page Setup to modify 
the current page setup. You can also select a different page setup in the current drawing or 
import one from a different drawing file.   

 

Upload a file to AutoCAD WS 
Within AutoCAD for Mac is an Upload Drawing Online option in the File menu that allows you to work with 
anyone anywhere. Uploaded drawing files can be viewed without AutoCAD for Mac using AutoCAD WS 
or AutoCAD WS Mobile. AutoCAD WS is a web based client that is accessible from a web browser, while 
AutoCAD WS Mobile is a native iOS application for the Apple® iPad™, iPhone®, and iPod touch®.  

You can collaborate with customers and clients without needing to send paper drawings, be in the same 
room, or install something to be able to edit and markup DWG files. With the web based client, you can 
even share drawings and work with another person in real-time to edit, markup, or discuss a design. 

And its FREE! 
 

                                                     

To sign-in or create an AutoCAD WS account, go to: http://www.autocadws.com 
AutoCAD WS Mobile for iPad, iPhone, or iPod touch can be downloaded by visiting the App Store and 
performing a search on AutoCAD WS. 

  3D Workflow 

You have most of the 3D creation and editing tools you have access to in AutoCAD for Windows 
such as meshes, solids, and surfaces. You also have favorites such as Presspull to easily create 
3D geometry. 
 
Visual Styles 
You have the ability to change the way 3D geometry is displayed from a wireframe to hand drawn 
looking effects.  
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Bonus: You can access and quickly change the current Visual Styles from the Visual Style control 
in the upper-left corner of the drawing area unlike AutoCAD for Windows which does not have 
this feature. 

Render 
You have the Autodesk common material library and the same rendering engine as AutoCAD for 
Windows. So when you need that pretty rendered picture you access it in the menu bar, or you 
guessed it, just enter RENDER at the command line just like AutoCAD for Windows. 

DWG 

AutoCAD for Mac uses the same exact DWG file format as the AutoCAD for Windows as well as 
Autodesk applications that create and consume DWG files. 100% drawing file compatibility is maintained 
when sharing files; there is no difference. This allows you to work on the same files as other users in your 
office and not be concerned with translations of the files, it is AutoCAD after all.  

You can open DWG files from 2.x which was released in 1983, making use of the millions of files that you 
or other Autodesk customers have created for past projects or received from customers and partners. 

Customization 
You can create custom scripts, linetypes, hatch patterns, and command aliases, as well as AutoLISP and 
ObjectARX applications for use with AutoCAD for Mac. However, there is no support for DCL or the 
Visual LISP components in AutoLISP. Some Technologies specific to Windows such as Visual Basic for 
Applications “VBA”, OLE objects, and Windows Media® Audio, are not supported in AutoCAD for Mac nor 
make sense in a native Mac application. 

AutoCAD for Windows and Mac Differences 

 

 
As I mentioned early on: 
“While not all features are included some just did not make sense for this first release or relied on platform 
specific technology. There are also some features in AutoCAD for Mac that are not in the AutoCAD for 
Windows version.” 
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The most commonly used functionality of AutoCAD is included in AutoCAD for Mac. However, there are a 
few commands that are not included in this first release, including layer filters and groups, and layer 
states are limited; Sheet Set Manager; and DGN, PDF, and DWF™ underlay support. Since this first 
release of AutoCAD for Mac is designed for the SMB in mind, there is no network license support. 

Some features are only in AutoCAD for Mac such as the enhanced QuickView, finger gestures, Cover 
Flow, Viewport label menus (or Viewport controls), and the 64-bit multi-threaded platform.  

At the end of the day, most features are there and you can use a native Mac application with 100% DWG 
file support. 

It is on the Mac and is AutoCAD. 

Resources 

AutoCAD for Mac Product page by Autodesk –  
http://www.autodesk.com/autocadformac  

AutoCAD for Mac 2011 Online Help Documentation by Autodesk –  
http://docs.autodesk.com/ACDMAC/2011/ENU/landing.html  

AutoCAD for Mac Documentation in PDF format for download –  
http://docs.autodesk.com/ACDMAC/2011/ENU/PDFs/PDF%20Documentation.htm  

AutoCAD for Mac Wiki by Autodesk –  
http://wikihelp.autodesk.com/AutoCAD_for_Mac/enu/Community 

Blogs: 
 
Between the Lines with me Shaan Hurley – http://autodesk.blogs.com 
 
MacACAD with Rick Graham – http://macacad.com/  

Communities: 
 
AutoCAD Exchange by Autodesk – http://autocad.autodesk.com/ 

Autodesk User Forums by Autodesk – http://forums.autodesk.com/  

Facebook – http://www.facebook.com/AutoCAD.3D  
 
AUGI Autodesk User Group International – http://www.augi.com  

Autodesk University Online – http://au.autodesk.com/  

Twitter  
You can follow the @autocad (http://www.twitter.com/autocad) account or the hashtags #autocad 
#autocadformac 


